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Introduction 
 
 
 The U.S. Army Engineer Research and Development Center (ERDC) is developing the Army Risk 
Assessment Modeling System (ARAMS) to provide the Army with the capability to perform human and 
ecologically based risk/hazard assessments associated with past practice and current activities at military 
installations.  The intent of the system is to provide a platform from which a variety of assessments can be 
performed.  The system is envisioned to help a risk analyst visualize an assessment from source, through 
multiple environmental media (e.g., groundwater, surface water, air, and land), to sensitive receptors of 
concern (e.g., humans and ecological endpoints).   
 
 ARAMS uses the Framework for Risk Analysis in Multimedia Environmental Systems (FRAMES) 
developed by the Pacific Northwest National Laboratory (PNNL) for linking disparate objects, such as 
environmental fate/transport models, databases, spreadsheets, etc.  FRAMES is a Windows-based 
software platform that provides an interactive user interface and, more importantly, specifications to 
allow a variety of DOS and Windows-based environmental codes to be integrated within a single 
framework.  
 
 This document is intended to serve as a tutorial for helping new users with the application of 
ARAMS/FRAMES and the components within this system.  This example does not include the steps for 
project planning and the use of associated tools under the “File” menu.  These tools help the user plan the 
risk assessment including development of the conceptual site model and the Risk Assessment Guidelines 
for Superfund (RAGS) Part D Table 1 for human health risk assessment.  There are several Help files 
within ARAMS that explain these tools. 
 
 
Example Description 
 
  
 This example (shown schematically in Figure 1) is fairly complex and demonstrates the versatility 
of ARAMS for analyzing multiple fate/transport pathways within a watershed.  The example begins with 
two areas of contaminated soil (Site 1 and Site 2) and uses the Plus Operator Object to combine the 
contaminated storm water runoff from both sites that feed into another downstream site. Additionally, 
volatiles from Site 1 are deposited onto the downstream site.  The downstream site is modeled with the 
Secondary Source in Soil Module within the Overland Flow Object using the combined runoff from Sites 
1 and 2 and air deposition computed by the MEPAS Air Module as inputs to calculate a contaminated 
runoff stream from the land area of the downstream site.  The runoff from the Overland Flow object flows 
into a stream and the MEPAS River Model is used to calculate the water concentration at a downstream 
extraction point.  The extracted water is used for drinking, showering, and watering vegetables in a 
garden. The Exposure Pathways, Receptor Intake, and Health Impacts modules are used to determine 
exposure, uptake, and risk caused by contaminated water and vegetables from the garden.  The object 
workspace for this example is shown in Figure 2. 
 
 Site 1, one of the originally contaminated sites, uses the MEPAS Source in Soil module, and the 
secondary overland site uses the MEPAS Secondary Source in Soil module to calculate the losses due to 
resuspension of particles, storm water runoff, degradation, and leaching.  The leaching pathway is not 
considered for Site 1 due to the presence of a leachate collection system; rather, the leachate collection 
system is treated as a known sink. The volatilization pathway is not considered for the secondary source 
site. Site 2, the other originally contaminated site, is a sediment trap and uses the User Defined WFF 
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(Water Flux File) Surface Water module to specify the known flux of water and constituents from the 
sediment trap. The constituent chosen for this example is PCB (General Classification). 
 
 

 

 
 
Figure 1.  Illustration of the scenario being modeled in this example 
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Figure 2.  Object workspace for example application  
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Input Data 
 

• Double-click on the ARAMS icon to open the “ARAMS info and Disclaimer” window and then 
select “Accept” to continue. 

 

ARAMS.lnk

 
 
• Choose “FRAMES” in the ARAMS toolbar to launch FRAMES.  (Note: If this is the first time 

you have used ARAMS, you may need to configure it for FRAMES by selecting “File,” then 
“***Must Configure Path to FRAMES***” and supplying the path to the “fui.exe” file). 

 
• While ARAMS/FRAMES is running, click “File” from the FRAMES menu and choose “New” 

(see Figure 3).  A window titled “Global Input Data Open New” will appear.  In the “File Name” 
box enter the project name (type: “Sample1,” maximum of eight characters) and click “Open” 
(see Figure 4). Do not name the new file “Example8” because it will write over the existing 
“Example8” file that was distributed with the tutorial.  A window titled “Create New Site” 
will appear. Next, type the project site name (type: Secondary Source Example) and click “OK” 
(see Figure 5).  
 

 The color of the workspace may change.  Double-click on the Constituent icon so that the icon 
appears on the upper left corner of the main screen. Repeat this operation to place the following additional 
icons into the workspace: 

 
 

“Source” 
“Air” 
“User-Defined” 
“Plus Operator” 
“Overland Flow” 
“Surface Water” 
“Exposure Pathways” 
“Receptor Intake” 
“Health Impacts” 

 
 Click on and drag each icon to its respective position on the workspace.  Connect the Constituent 
icon and Source icon by holding down SHIFT, clicking on the Constituent icon, dragging the cursor to the 
Source icon, and releasing the mouse button (Note: To remove this line, repeat the steps used to connect 
it.  To remove an icon from the screen, right click and a menu will appear with various options.  Click 
“Delete” and the icon will be removed.).  Lines from the Constituent icon can be made transparent to 
make the object work space less cluttered by clicking Customize on the FRAMES menu bar, clicking 
Colors, making sure Database Connections is highlighted, then un-checking Visible. 

  
Connect the following pairs of icons: 
 

 
  Constituent    → Source (already done) 
  Constituent    → Air 
  Constituent    → User-Defined  
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  Constituent    → Overland Flow 
  Constituent    → Surface Water 
    Constituent    → Exposure Pathways 
  Constituent    → Receptor Intake 
  Constituent    → Health Impacts 
  Source    → Air 
  Source    → Plus Operator 
  User-Defined    → Plus Operator 
  Plus Operator   → Overland Flow 
  Air     → Overland Flow 
  Overland Flow   → Surface Water 
  Surface Water   → Exposure Pathways 
  Exposure Pathways   → Receptor Intake 
  Receptor Intake   → Health Impacts 

   
FRAMES should now look something like Figure 2.  

 

 
 

Figure 3.  Opening a new file 
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Figure 4.  Global Input Data Open New screen (new file window) 
 

 

 
 

Figure 5.  Create New Site screen (input “Site name” box) 
 
 

CONSTITUENTS DATABASE MODULE 
 
 Right-click the Constituent icon and choose “General Info” (see Figure 6). When the General Info 
screen opens, enter “Constituent” in the “User Label” text box and select “FRAMES Constituent 
Database Selection” in the “Select from applicable models” text box (see Figure 7).  Click OK at the 
bottom of the screen to return to the workspace area.  The Constituent icon’s status indicator will now 
display a red light.   Right-click on the constituent icon in the main screen and choose “User Input.” The 
Constituent Selection screen will open (see Figure 8).  The constituent used in this case is PCB (General 
Classification).  Scroll to select the constituent from the constituents list or use the Find option to search 
for it.  Click the “Add >>>” button to add PCB to the selected constituents list.  Select “Save and Exit” 
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from the File menu to return to the workspace screen.  The Constituent icon’s status light will change 
from red to green.  

 

 
 

Figure 6. Workspace screen (right-click on the Constituent icon) 
 
 

 



 10

 
 

Figure 7. Object General Information screen 
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Figure 8.  FRAMES Constituent Selection screen (“Constituents of Concern” tab) 
 
 
 The following is a listing of all data input required by the remaining modules used in this example.  
Names of object icons are in bold, italics, and underlined headings.  Menu items (displayed by right-
clicking on the icon) are shown below the module in bold and indented to the right of the icon names.  
Explanations of data required by each menu item are indented further to the right.  To save information 
for your scenario, select “File” and then “Save” from the main FRAMES menu. 
 
 For ease of presentation, the instructions below proceed with selecting module, entering data, running 
the module, and viewing module output.  However, the user should select all object modules prior to 
entering data for each module. 
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Source 
 

General Info 
 

A window titled “Object General Information” will appear. Input  “Site 1” in the Label 
text box. Select “MEPAS 5.0 Source in Soil” in the section labeled “Select from 
Applicable Models.” Note the northing, easting, and elevation fields at the top left corner 
of the form. These are used to enter the coordinates in three-dimensional space relative to 
a user-defined origin. For this example, Site 1 is assumed to be the origin so these values 
will all be zero. Click the button labeled “OK” to return to the FRAMES workspace. The 
status light next to the Source icon should turn red. 
 

User Input 
 

In the window titled “Source Term Module Input,” enter the information for each of the 
tabs as described below. 
 
• Options Tab (for pathway and simulation settings) – Figure 9 

o Turn off leaching loss route since a leachate collection system is used 
o Set the overland runoff loss route as a known erosion rate 
o Set the volatilization and suspension loss routes to compute pathway fluxes 
o Set the known source/sink option to a known constituent flux because the 

values from the leachate collection system will be entered 
o Time interval for the simulation is 1 year, which is presently fixed  
o Time period for the simulation is 130 years 
o Fraction of residual mass for the simulation is 0.01 

 

 
 
Figure 9.  MEPAS Source in Soil Model – Options tab 
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• Waste Zone Tab (soil and other physical properties) – Figure 10 

o Thickness of clean overburden = 0 cm 
o Thickness = 3 m 
o Length = 100 m 
o Width = 100 m 
o Bulk density = 1.6 g/cm3 
o Total porosity = 0.4 
o Moisture content = 0.15 
o Volumetric air content is computed 
o Average air temperature = 25˚C 
o Height above ground of local wind measure = 10 m 
o Mean annual wind speed = 5 m/sec 

 

 
 
Figure 10.  MEPAS Source in Soil Model – Waste Zone tab 
 

 
• Overland Tab (overland flow data) – Figure 11 

o Discharge of water to overland = 5000 m3/yr 
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Figure 11.  MEPAS Source in Soil Model – Overland tab 
 

 
• Suspension Tab – Figure 12 

o Figure 12 shows the inputs for the soil suspension model.  This suspension 
model is based on a 1985 report by Chatten Cowherd of the Midwest 
Research Institute prepared for the EPA Office of Health and Environmental 
Assessment.  Set all parameters to those shown in Figure 12. 
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  Figure 12.  MEPAS Source in Soil Model – Suspension tab 
 

• Kd’s Tab (Soil partitioning parameters) – Figure 13 
o Set the count to “2”.  This will allow the user to enter values for the 

equilibrium coefficient at two different time points.  Options are available 
from the dropdown box as shown in Figure 13 (the value from the constituent 
database, an estimated value based upon soil properties, and a value from a 
look-up table for metals), and the user can enter values directly in the Value 
field.  The value is shown first followed by the source of the data.  The 
estimated value will be used in this example.  The user must click the “Soil 
Properties” button, and the form shown in Figure 14 will appear.  Values 
should be entered such that they equal 100 percent.  Note that the type of soil 
could also be chosen from the list at the top right corner of the form. Making 
a selection from this list will automatically fill in the percentage of each 
component in the soil.  Values shown in Figure 14 should be entered, 
“Apply” should be clicked, and the “estimated” values of 8892.7 ml/g should 
be used as shown in Figure 13. 
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Figure 13.  MEPAS Source in Soil Model – Kd’s tab 
 

 
 
Figure 14.  Soil Properties Dialog 

 
• Constituent Properties Tab (Chemical properties and inventory) – Figure 15 

o Ensure that a value for water solubility for PCB of 0.031 mg/L was passed 
from the Constituent Database to this screen as shown in Figure 15.  Note 
that if a value exists for the water solubility for any of the chemicals in the 
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FRAMES Constituent Database, as is the case for PCB, it will appear in the 
appropriate box on this form.  

o Use the “Worksheet” button to enter the inventory as shown in Figure 16. 
This is the original amount of material present.  The two input options 
available are “Inventory” and “Concentration.”  The inventory option allows 
the user to specify the mass of the constituent present initially, while the 
concentration option allows the user to specify a concentration of the 
constituent present on a mass of dry soil, mass of wet soil, or volume of soil 
basis.  Use the Inventory option and enter the value for PCB of 300 kg 

o Enter a decay/degradation half-life for PCB of 43800 days.  Note that this 
value will also be filled from the database if present. 

o The fraction of volatilization release is used to control the volatilization rate 
at the constituent level if the user determines that the model-estimated 
volatilization rate is too high. This value is generally set to 1 for most 
constituents and should only be changed if the user has monitoring data that 
can be used to estimate the adjustment required to define this value. 

 
 

 
 
Figure 15.  MEPAS Source in Soil Model – Constituent Properties tab 
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Figure 16.  Constituent Inventory Worksheet 
 

• Known Media Releases Tab (Known Erosion Rates) – Figure 17 
o Since the overland runoff loss route was set to a known erosion rate, the 

erosion rate must be defined on this tab.  Enter a value for the soil depth lost 
to water erosion of 1 cm/year for 0 and 130 years; thus, a constant erosion 
loss rate is assumed for this example.   
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Figure 17.  MEPAS Source in Soil Model – Known Media Releases tab 
 
 

• Known Constituent Flux Tab – Figure 18 
o The known constituent fluxes are specified on this screen.  For this example, 

the only known flux selected on the Options tab was for the “known 
source/sink,” which is the leachate capture system.  A constant value of         
-1000 g/yr should be set for two years, year 0 and year 130.  The minus sign 
indicates that mass is taken out of the soil, thus a sink.   

 



 20

 
 
Figure 18.   MEPAS Source in Soil Model – Known Constituent Flux tab 
 

 
After all of the information on each tab has been entered, select “Save and Exit” from the 
File menu to return to the FRAMES workspace. The status indicator next to the Source 
icon will change to yellow to indicate that the inputs have been entered. 
 

Run Model 
 

The model runs in the background. The status light next to the Source icon should turn 
green. 
 

View/Print Module output 
 

A second menu will appear (see Figure 19). Choose “SCF Graphical View” to view a 
screen output for soil concentrations in Excel format (see Figure 20). There are also 
similar viewers for air flux (AFF) and overland water flux (WFF). 
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Figure 19.  Output Menu for the MEPAS Source in Soil Module 
 
 

 
 
Figure 20.  Graphical SCF Viewer Output 
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User Defined 
 

General Info 
 
A window titled “Object General Information” will appear.  Enter 0.5 for both the 
northing and easting coordinates and –0.005 for the elevation.  This indicates that Site 2 
is 0.5 km to the north and east of Site 1 and is 5 m lower in elevation.  In the Label text 
box, input “Site 2.” In “Select from Applicable Models,” choose “WFF Surface Water 
Module” and click “Ok.”  The status light next to the User Defined icon should turn red.  
It is important to recognize that the User Defined Surface Water module covers fluxes 
from a variety of surface water types, including lakes, streams, as well as sedimentation 
traps as for this example.  It can also be used for overland flow fluxes, but there is also a 
User Defined WFF Overland Flow module that is identical to the WFF Surface Water 
module. 
 

User Input 
 

A window titled “FRAMES User Defined Module” will appear. Enter the data as given 
below and shown in Figure 21. 
 
Width of Flux Plane = 500 m 
Height of Flux Plane = 0.1 m 

 
• Water Flux 

o 100,000 m3/year at 0 years 
o 100,000 m3/year at 130 years 

 
• PCB (General Classification) Adsorbed Flux 

o 1000 g/year at 0 years 
o 1000 g/year at 50 years 
o 0 g/year at 51 years 

 
• PCB (General Classification) Dissolved Flux 

o 0.0 g/year at 0 years 
o 0.0 g/year at 50 years 
o 0.0 g/year at 51 years 

 
Choose  “Save and Exit” from the File menu to return to the FRAMES work space.  The 
status light next to the User Defined icon should turn yellow. 
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Figure 21.  WFF Surface Water Module Input screen 
 
 

Run Model 
 

The model runs in the background.  The status light next to the User Defined icon should 
turn green.   
 

View/Print Module output 
 

A second menu will appear. Choose “WFF Graphical View” to view a screen output in 
Excel format (see Figure 22). 
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Figure 22.  Graphical WFF Viewer Output 
 
 

Plus Operator 
 

General Info 
 
The Plus Operator is used to combine mass fluxes or concentrations when two or more 
media export mass to a downstream medium.  A window titled “Object General 
Information” will appear.  The Plus Operator is assumed to be at the same location as the 
Secondary Source since this is where the two runoff streams will combine to contaminate 
the Secondary Source land surface.  Enter 0.5 for the easting coordinate, 0 for the 
northing coordinate, and –0.01 for the elevation. In the Label text box, input “Plus 
Operator.” In “Select from Applicable Models,” choose “WFF Surface Water Plus 
Operator” and click “Ok.”  The status light next to the Plus Operators icon should turn 
red.  Note that the Surface Water Plus Operator is also applicable to overland flow, but an 
identical Overland Flow Plus Operator is available too. 
 

User Input 
 
The Plus Operator object does not require any user input since it is simply taking the 
output from two upstream modules and combining them to produce a single output file. 
In this case a Water Flux File (WFF) will be produced, which is the sum of runoff from 
Site 1 and Site 2. 
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Run Model 
 

The model runs in the background.  The status light next to the Plus Operator icon should 
turn green.   
 

View/Print Module output 
 

A second menu will appear. Choose “WFF Graphical View” to view a screen output in 
Excel format (see Figure 23).  The output from this module will be the sum of the outputs 
from the MEPAS Source in Soil (Site 1) and the WFF Surface Water (Site 2) modules.  
Notice how the combined fluxes drop at year 50 due to the cessation of Site 2 PCB fluxes 
at that time.  The cumulative mass flux is also shown on the plot. 
 
 

 
 
Figure 23.  Plus Operator Graphical WFF Viewer Output 

 
 

Air 
 

General Info 
 
The Air module will simulate the transport of material from Site 1 to other locations, 
including the secondary source site.  A window titled “Object General Information” will 
appear.  The origin of the air model is assumed to be coincident with the origin of this 
scenario and Site 1, so it will have the same coordinates and elevation as Site 1, which is 
the origin.  In the Label text box, input “Air.”  In “Select from Applicable Models,” 
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choose “MEPAS 5.0 Air Module” and click “Ok.” The status light next to the Air icon 
should turn red. 
 

User Input 
 
A screen titled “MEPAS Atmospheric Module” will appear. There are three main tabs 
containing fields that must be filled by the user. Enter the information for each tab as 
given below. For further information on any of these fields, select “How to …” from the 
Help menu or press the F1 key to go directly to the information for the current field. 
 
• The first tab labeled “Climatology” is shown in Figure 24 and contains general 

climatological data.  
 

o Reference Weather Station – identifier of the weather station where the data 
was obtained (this field is not required and may be left blank) 

o Morning mixing height = 400 m 
o Afternoon mixing height = 900 m 
o Annual precipitation = 10 in. 
o Precipitation days per year = 70 
o Thunderstorms per year = 25 

 

 
 
Figure 24.  MEPAS Atmospheric Module – Climatology tab 

 
 
• The second tab is the “Joint Frequency Data” tab shown in Figure 25.  This tab will 

be used to input data pertaining to the relative frequencies of various wind conditions 
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for the area surrounding the current site.  There are eight tabs under the Joint 
Frequency Data section.  The tab labeled “General” is used to enter general 
information pertaining to the frequency data.  The other seven tabs labeled “Class A” 
through “Class G” contain tables for entering information about each of these wind 
stability classes.  Wind frequency data can be obtained through the STAR 
PROGRAM summaries from the National Climatic Data Center (NCDC) in 
Asheville, North Carolina, which is operated by the National Oceanic and 
Atmospheric Administration (NOAA's) Environmental Data Service.  A file 
containing joint frequency data (JFD) will be imported and used to fill the tables in 
this example.  There are plans to have an ARAMS utility that will take NOAA data 
and develop the JFD file.  Click the button labeled “Import Joint Frequency Data” at 
the bottom of the “General” tab.  Select the file titled “JFData.jfd” from the 
FRAMES directory as shown in Figure 26 and select “OK.”  The data for the “Wind 
joint frequency calms” section on the “General” tab will be filled in along with the 
tables for the wind stability classes on the remaining tabs.  Enter the additional data 
given below on the “General” tab as shown in Figure 25. 

 
o Anemometer height = 10 m 
o Average roughness length = 2 cm 
o Wind speed midpoints 

o Group 1 = 0 m/s 
o Group 2 = 2 m/s 
o Group 3 = 3 m/s 
o Group 4 = 4 m/s 
o Group 5 = 5 m/s 
o Group 6 = 6 m/s 
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Figure 25.  MEPAS Atmospheric Module – Joint Frequency Data tab 
 
 

 
 
Figure 26.  Selection of a Joint Frequency Data File for Importing 
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• The last tab is labeled “Topographical Data” and is used to enter information for 

elevated releases or information about the topography of the site if the terrain will be 
assumed to influence the atmospheric movements.  For this example, the default 
values will be used as shown in Figure 27 so no further input is required.  Select 
“Save and Exit” from the File menu to return to the FRAMES work space. The status 
light next to the Air icon should turn yellow. 

 

 
 
Figure 27.  MEPAS Atmospheric Module – Topographical Data tab 

 
 

Run Model 
 

The model runs in the background.  The status light next to the Air icon should turn 
green.   
 

View/Print Module output 
 

A second menu will appear.  Choose “GNUPLOT ATO Concentrations” to view a three-
dimensional plot of the constituent concentrations and deposition rates in the atmosphere 
around the current site.  A dialog will appear prompting the user for the center coordinate 
for both northing and easting as well as the time span and time interval for the graphs that 
will be created (see Figure 28).  Accept the default values and click the “Convert” button 
to load the first graph. This viewer will produce plots at different time intervals of the 
constituent concentrations in air as well as deposition rates (Figure 29). 
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Figure 28.  GNUPLOT ATO Converter Dialog 
 
 
 

 
 
Figure 29.  Plot of PCB deposition rates at Site 1 after 6 years 
 
 

Overland Flow 
 

General Info 
 

A window titled “Object General Information” will appear.  Enter 0.5 for the easting 
coordinate, 0 for the northing coordinate, and –0.01 for the elevation.  The location can 
affect how much deposition from air is received from the air model.  In the Label text 
box, input “Secondary Source.” In “Select from Applicable Models,” choose “Copy of 
MEPAS 5.0 Secondary Source in Soil” and click “Ok.” The status light next to the 
Overland Flow icon should turn red. 
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User Input 
 
Since this module is a copy of the MEPAS 5.0 Source in Soil, the module and the inputs 
are similar to those explained for the MEPAS Source in Soil module that was used to 
model Site 1. The main difference in the Secondary Source module is that the source/sink 
terms are automatically set to use the secondary source fluxes from the Plus Operator and 
MEPAS Air Module.  Note that the known source/sink option is preset to “Use 
Secondary Sources” as shown in Figure 30.  Enter the data for each tab as given below. 
 
• Options Tab (for pathway and simulation settings) – Figure 30 

o Turn off the leaching loss route 
o Set the overland runoff loss route as a known erosion rate 
o Turn off the suspension and volatilization loss routes 
o Time period for the simulation is 130 years 
o Fraction of residual mass for the simulation is 0.01 

 

 
 
Figure 30.  Secondary Source Term Module Input – Options tab 
 
 

• Waste Zone Tab (soil and other physical properties) – Figure 31 
o Thickness of clean overburden = 0 cm 
o Thickness = 0.2 m 
o Length = 2 km 
o Width = 2 km 
o Bulk density = 1.1 g/cm3 
o Total porosity = 0.6 
o Moisture content = 0.2 
o Average air temperature = 25˚C 
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o Height above ground of local wind measure = 10 m 
 

 
 
Figure 31.  Source Term Module Input – Waste Zone tab 
 
 

• Overland Tab (overland flow data) 
o Discharge of water to overland = 2.0 E6 m3/year 

 
• Kd’s Tab (Soil partitioning parameters) 

o Estimate the value as before for Site 1 using the same soil properties to get a 
value of 8892.7 ml/g. 

 
• Constituent Properties Tab (Chemical properties and inventory) 

o Ensure the value from the database of 0.031 mg/L is passed to this screen. 
o Use the “Worksheet” button to enter the inventory of negligible mass on the 

site initially.  A zero value is not allowed, so a very small value of 1.0 E-20 
is entered instead.   

o Enter a decay/degradation half-life of 43800 days, but this value should be 
passed from the database. 

o The fraction of volatilization release is not enabled because this pathway was 
turned off on the Options tab. 

 
• Known Media Releases Tab (Known Erosion Rates) 

o Enter the following values as specified. 
 Soil depth lost to water erosion = 0.1 cm/year at 0 years 
 Soil depth lost to water erosion =  0.1 cm/year at 130 years 
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When all of the information on each tab has been entered, select “Save and Exit” from 
the File menu to return to the FRAMES workspace. The status indicator next to the 
Overland Flow icon will change to yellow to indicate that the inputs have been entered. 
 

Run Model 
 

The model runs in the background. The status light next to the Overland Flow icon 
should turn green. 
 

View/Print Module output 
 

A second menu will appear. Choose “WFF Graphical View” to view fluxes from this site 
in a screen output in Excel format (see Figure 32).   
 
 

 
 
Figure 32.  Graphical WFF Viewer Output 
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Surface Water 
 

General Info 
 

A window titled “Object General Information” will appear. Enter 0.5 for the easting 
coordinate, –0.5 for the northing coordinate, and –0.015 for the elevation.  However, the 
location of the surface water object does not matter for this example since the MEPAS 
River Module does not accept air deposition.  In the Label text box, input “Surface 
Water.” In “Select from Applicable Models,” choose “MEPAS 5.0 River Module” and 
click “Ok.”  The status light next to the Surface Water icon should turn red. 

 
User Input 
 

A window titled “MEPAS River Module” will appear (Figure 33). Enter the data as given 
below for each tab. 
 

• Dimensions Tab (physical properties of the river) – Figure 33 
o Flow velocity at constituent entry point = 0.5 m/sec 
o Depth at constituent entry point = 2 m 
o Width at constituent entry point = 20 m 
o There is only one Exposure Pathways object so the usage location is 

automatically set to this object. Enter the properties given for the river at 
the usage location. 

 
 Distance from source (entry point)  to (exposure) location =  

      5 km 
 Average annual discharge at location = 20 m3/sec 

 

 
 
Figure 33.  MEPAS River Module – Dimensions tab 
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• Constituent Properties Tab (chemical properties for each constituent) – Figure 34 

o PCB (General Classification) 
 Water solubility = 0.031 mg/L 
 Half-life in surface water = 20 yr 

 
When all of the information on each tab has been entered, select “Save and Exit” from 
the File menu to return to the FRAMES work space. The status indicator next to the 
Surface Water icon will change to yellow to indicate that the inputs have been entered. 
 

 
 
Figure 34.  MEPAS River Module – Constituent Properties tab 
 

 
Run Model 
 

The model runs in the background. The status light next to the Surface Water icon should 
turn green. 

 
View/Print Module Output 
 

A second menu will appear. Choose “WCF Graphical View” to view water 
concentrations in a screen output in Excel format (see Figure 35). 
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Figure 35.  WCF graphical viewer output for MEPAS River Module 
 
 

Exposure Pathways 
 

General Info 
 

The Exposure Pathways object has been discussed in other tutorials and will be 
mentioned only briefly here.  Enter 0.5 for the easting coordinate, -1 for the northing 
coordinate, and –0.02 for the elevation.  However, the locations don’t matter for this 
example since the exposure location was set in the river module, relative to the river (i.e., 
distance downstream).  In the Label text box, input “Exposure Pathway.” In “Select from 
Applicable Models,” choose “MEPAS 5.0 Exposure Pathways Module” and click “Ok.” 
The status light next to the Exposure Pathways icon should turn red. 

 
User Input 
 

Enter the data given for each of the tabs on the MEPAS Chronic Exposure Module 
screen. 
 

• Surface Water Tab 
o Exposure duration = 30 years 
o Pathways Tab 

  
 Select “Leafy vegetables,” “Drinking water,” and “Shower 

water” for ingestion pathways; “Air volatiles from water” with 



 37

“Shower – Air” as the suboption for the inhalation pathway, and 
“Shower water” for dermal pathway as the pathways to be 
considered 

o Water Usage Tab (default values are used) 
 Fraction of year that surface water is used for irrigation = 1 
 Irrigation rate = 100 L/m2/month 
 Domestic water distribution time = 0.5 day 
 Domestic water is not treated 

o Recreational tab (no pathways are considered that would affect data on 
this tab) 

• Exposure Controls Tab 
o Time to start exposure computation = 0 years 
o Maximum time for reporting = 100 years 
o Number of time points for evaluation = 50 

• Leach Rates Tab (leach rates are set to low values to simulate a worst case 
scenario where leaching losses are minimal) 

o Leachate selection option = “User provided leach rate constants” 
o Surface soil leach rate constant for PCB = 0.0 /year 

• Constituent Parameters Tab 
o Half-life in soil = 10 years 
o Half-life in surface water and groundwater = 20 years 
o Half-life in air = 1.0 E20 day 

 
Changes can also be made to other parameters such as on the “Soil and Crop,” “Growing 
Period,” and other screens by selecting “Customize” from the menu.  Default values were 
used for this example. Choose “Save and Exit” from the File menu. The status indicator 
next to the Exposure Pathways icon should turn yellow.   
 

Run Model 
 

The model runs in the background. The status light next to the Exposure Pathways icon 
should turn green. 

 
View/Print Module Output 
 

Refer to Example 4 for a sample of output data from the Exposure Pathways object. 
 
 

Receptor Intake 
 

General Info 
 

The Receptor Intake object has been discussed in other tutorials and will be mentioned 
only briefly here.  Enter 0.5 for the easting coordinate, -1 for the northing coordinate, and 
–0.02 for the elevation.  In the Label text box, input “Receptor Intake.” In “Select from 
Applicable Models,” choose “MEPAS 5.0 Receptor Intakes Module” and click “Ok.” The 
status light next to the Receptor Intake icon should turn red. 
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User Input 
 

Enter the data given below. All default values are used for this example.   
 

• Body weight of individual = 70 kg 
• Exposure duration = 30 years 
• Water dermal absorption model = “EPA model” 
• Ground water ingestion rate = 2 L/day 
• Surface water ingestion rate = 2 L/day 
• Age of receptor at start of exposure = 0 years 
• Age of receptor at end of exposure = 70 years 
• Method for inhalation impact analysis = “Air concentration” 

 
Additional parameters may be modified by selecting “Customize” from the menu. 
However, all default values for this module were used for this example as stated earlier. 
Choose “Save and Exit” from the File menu.  The status indicator next to the Receptor 
Intake icon should turn yellow. 

 
Run Model 
 

The model runs in the background. The status light next to the Receptor Intake icon 
should turn green. 

 
View/Print Module Output 
 

Refer to Example 4 for a sample of output data from the Receptor Intake object. 
 

 
Health Impacts 
 

General Info 
 

The Health Impacts object has been discussed in other tutorials and will be mentioned 
only briefly here.  Enter 0.5 for the easting coordinate, -1 for the northing coordinate, and 
–0.02 for the elevation.  In the Label text box, input “Health Impacts.” In “Select from 
Applicable Models,” choose “MEPAS 5.0 Health Impacts Module” and click “Ok.” The 
status light next to the Health Impacts icon should turn red. 

 
User Input 
 

Enter the data given below. All default values are used for this example. 
 

• Chemical Tab 
o Calculate lifetime cancer incidence = True 
o Calculate hazard index = True 

o Hazard quotient threshold limit = 0 
o Method for inhalation impact analysis = “Air concentration” 

 
Choose “Save and Exit” from the File menu. The status indicator next to the Health 
Impacts icon should turn yellow. 
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Run Model 
 

The model runs in the background. The status light next to the Health Impacts icon 
should turn green. 

 
View/Print Module Output 
 

A second menu will appear.  Choose “HIF Graphical View,” select “Risk” for unit of 
“Measure,” and click “Chart” to generate the cancer risk versus time graph shown in 
Figure 36.  Note how the risk peaks around year 50.  Next choose “Summary Views of 
Risk, Hazard and Dose,” and then select the 50-year time point to view the screen shown 
in Figure 37.  This viewer shows summary data and totals for the exposure pathways that 
were chosen. The user can select options such as the location, exposure medium, 
constituent and time point to determine the data that are shown.  This viewer gives a clear 
indication of the risk contributions of each pathway and route.  For this example, the 
shower dermal and shower air inhalation pathway-routes are the greatest risk 
contributors. 
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Figure 36.  Health Impacts viewer – HIF Graphical View  
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Figure 37.  Summary Viewer for Health Impacts Module  
 
 


